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Uso previsto 
 

 
Uso Previsto 
 
Se emplea para transmitir imágenes DICOM desde un digitalizador de imágenes 
médicas a un proveedor de clase de impresión o a un proveedor de clase de 
almacenamiento DICOM. Está dirigido a usuarios que desean utilizar un 
digitalizador de  radiografías médicas para digitalizar radiografías analógicas o 
transmisivas en una estación de trabajo DICOM mediante telerradiología 
tradicional, así como a usuarios que quieren obtener duplicados de radiografías 
impresas usando tecnología digital en protocolos postscript y DICOM. 
 
Usuario Previsto 
 
Los usuarios objetivo de estos dispositivos son profesionales médicos o personal 
capacitado para su uso como imágenes de captura secundarias para consulta, 
revisión e interpretación final.  
 
No hay requisitos de educación para el usuario. El usuario debe estar 
familiarizado con el manejo de películas de rayos X y el uso de equipos de 
oficina como una PC. El usuario debe leer la guía del usuario para comprender 
cómo cargar películas en el digitalizador de películas. El usuario deberá estar 
familiarizado con el software utilizado en la PC para adquirir la imagen 
escaneada. 
 
Aviso a los Usuarios 
 
No hay advertencias ni precauciones. El dispositivo es de contacto no paciente. 
No se requieren contraindicaciones, contraindicaciones ni precauciones. 
 
En caso de que ocurra cualquier incidente grave en relación con el dispositivo, 
informe al fabricante y a la autoridad competente del Estado miembro en el que 
esté establecido el usuario y / o paciente. 
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Seguridad, Rendimiento, 
Almacenamiento y Manejo 

 

 
Seguridad y rendimiento 
 
• Dado que este es un programa de software instalado en una PC con Windows 
host, no hay problemas de seguridad con el producto. El rendimiento del 
producto está controlado por la salida del dispositivo que proporciona los datos y 
por la capacitación y el conocimiento del usuario. 
 
• Se espera que el usuario pueda evaluar y ajustar las imágenes utilizando las 
herramientas del software para maximizar la calidad de la imagen antes de 
enviarla a PACS. 
 
Almacenamiento y manipulación 
 
• Maneje los discos por el borde exterior o el orificio central. 
• Mantenga la suciedad u otras materias extrañas del disco. 
• Almacene los discos en posición vertical (estilo libro) en cajas de plástico 
provistas con el CD 
• Devuelva los discos a las cajas de almacenamiento inmediatamente después de 
su uso. 
 
• La persona responsable de la estación de trabajo del software debe almacenar el 
CD del software ClinicalExpress en un lugar seguro. Se requerirá el CD si alguna 
vez se reemplaza la PC o si ocurre una falla con el disco duro de la PC. 
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Acerca de este manual 
 

Este manual proporciona instrucciones detalladas para instalar y utilizar 
ClinicalExpress®. El manual está organizado en los siguientes temas: 

 Acerca de ClinicalExpress describe ClinicalExpress como parte de un 
sistema DICOM para radiografía o mamografía típico. 

 Instalación de ClinicalExpress repasa los requisitos del sistema y 
proporciona instrucciones para la instalación del software. 

Nota: consulte la información relativa a la conectividad en la 
declaración de conformidad DICOM, un documento aparte. 

 Configuración de ClinicalExpress explica cómo configurar los sistemas  
de captura y transmisión de radiografías de ClinicalExpress, así como otros 
temas de interés para los administradores de sistemas ClinicalExpress. 

Nota: las instrucciones de funcionamiento figuran en otro 
manual, la “Guía del usuario de ClinicalExpress”. 

Convenciones utilizadas en este manual 

 Las teclas especiales que el usuario tiene que pulsar en el teclado se indican en 
LETRAS VERSALITAS. Por ejemplo, si en el texto aparece la palabra ENTRAR, hay 
que pulsar la tecla correspondiente del teclado. 

 Los nombres y los comandos de los menús se indican en letras mayúsculas. 
Por ejemplo, el menú Archivo (File) incluye el comando Instalar licencia 
(Install License). En este manual, los comandos se expresan en una notación 
abreviada. Por ejemplo, Archivo > Salir (File > Exit) significa seleccionar el 
comando Salir (Exit) del menú Archivo (File). 

 Los nombres de las ventanas, botones, cuadros de diálogo y otros elementos 
que aparecen en la pantalla se indican en negrita. Por ejemplo, la ventana 
Inicio de sesión de ClinicalExpress (ClinicalExpress Login) (a 
continuación) contiene los campos Nombre de usuario (User Name) y 
Contraseña (Password), así como los botones Aceptar (OK) y Cancelar 
(Cancel). 
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Acerca de ClinicalExpress®
 

 

 
 
 
ClinicalExpress 6.0 es un programa para Windows que permite digitalizar 
radiografías y transmitir imágenes radiográficas. El programa incorpora los 
modos de Radiografía general y Mamografía, y se puede adquirir solo para 
Radiografía general, solo para Mamografía o para ambos modos. 
 
Digitalización. Usando como dispositivo de entrada un digitalizador de 
radiografías VIDAR, ClinicalExpress presenta imágenes radiográficas y las 
asocia con un determinado paciente y estudio. El programa ofrece una serie de 
controles para examinar las imágenes a efectos de control de calidad y ajustar sus 
características. 
 
Indicaciones de uso. Las imágenes de radiología general digitalizadas con 
ClinicalExpress cumplen o superan el estándar DICOM o el del ACR relativos al 
uso de imágenes de captura secundaria con fines de consulta, revisión e 
interpretación final. 

 
Las imágenes mamográficas digitalizadas con ClinicalExpress como imágenes 
DICOM MG deben usarse únicamente como referencia o con fines de 
comparación, no para el diagnóstico principal. 
 
 
 
Opciones 
 
Las siguientes opciones se pueden adquirir por separado: 
 
Lista de trabajo de modalidad (Modality Work List o MWL). Esta opción 
permite a las modalidades de adquisición de imágenes descargar información  
de listas de trabajo de procedimientos programados y datos relacionados, 
presentar dicha información al operador de la modalidad y garantizar que las 
imágenes DICOM contienen datos descriptivos coherentes. En este manual se 
explica cómo usar la lista de trabajo de modalidad en ClinicalExpress. Los 
detalles de la integración figuran en la declaración de conformidad DICOM. 
 
PDI. Esta opción incluye las funciones de Medios de Importación/Exportación 
DICOM (para leer y grabar CD DICOM), Digitalización plana en papel y 
Consulta de pacientes (para buscar información de pacientes en dispositivos  
de almacenamiento). 
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Descripción general del sistema 

La estación de trabajo de captura y transmisión de radiografías ClinicalExpress 
normalmente consta de lo siguiente: 

 Digitalizador de radiografías VIDAR para crear imágenes digitales a partir 
de radiografías. 

 Ordenador con Windows® XP 32 bits o Windows 7 32 o 64 bits y el 
programa ClinicalExpress instalado. 

Notas 

 La estación de trabajo ClinicalExpress NO es una estación 
de trabajo para diagnóstico. Para fines de diagnóstico, use 
una estación de trabajo adecuada (consulte las instrucciones 
de la guía de instalación y funcionamiento de la estación de 
diagnóstico). 

 Las imágenes mamográficas digitalizadas con 
ClinicalExpress deben usarse únicamente como referencia y 
con fines de revisión, no para el diagnóstico principal. 

Modo de radiografía general 

Para transmitir imágenes, la estación de trabajo utiliza una conexión de datos que 
envía los datos de imagen a una estación de trabajo o sistema remotos. Para hacer 
copias, la estación de trabajo se conecta a una impresora de radiografías o a un 
dispositivo de salida no radiográfico. Como dispositivo de entrada de datos 
también se puede utilizar un escáner de documentos opcional. 
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Modo de mamografía 
 
Para transmitir imágenes, la estación de trabajo utiliza una conexión de datos que 
envía los datos de imagen a una estación de trabajo o sistema remotos. 
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Qué se puede hacer con ClinicalExpress 
ClinicalExpress 6.0 funciona como un centro de control para la captura, 
transmisión y copia de radiografías. El programa permite: 

 Digitalizar. 
 Designar un paciente y un estudio, o crear un nuevo historial de paciente  

o estudio. 
 Usar la opción de Lista de trabajo de modalidad (disponible por separado) 

para obtener información de los pacientes desde un origen externo (en 
lugar de introducir los datos del paciente con el teclado). 

 Configurar los parámetros de digitalización básicos: la resolución y la 
profundidad en bits. 

 Digitalizar una o más radiografías. 
 Comprobar la calidad de la imagen creada a partir de la radiografía antes 

de enviarla o copiarla. 
 Modificar la imagen: ajustar la ventana y el nivel, girar, voltear, invertir los 

tonos, dividir imágenes, ampliar una región de interés, aumentar la escala y 
redactar información confidencial. 

 Transmitir. 
 Seleccionar una estación de trabajo o sistema remoto (el “destino”). 
 Enviar imágenes digitalizadas al destino seleccionado. 
 Digitalizar y enviar en una sola operación. 

 Copiar (solo en el modo de radiografía general). 
 Seleccionar una impresora (si hay varias impresoras conectadas al sistema). 
 Especificar el número de copias que se quieren hacer de cada radiografía 

original. 
 Iniciar la impresión. 
 Combinar múltiples imágenes en una radiografía. 
 Digitalizar e imprimir en una sola operación. 

 Importar y exportar a CD compatibles con el estándar DICOM. 

Las licencias se otorgan dependiendo de las características y funciones que 
incluya ClinicalExpress. Todas las licencias incluyen la función de digitalización 
y las funciones DICOM de Envío (envío a proveedores de clase de servicio 
DICOM, estaciones de trabajo/PACS) y Copia (impresión en impresoras DICOM 
o dispositivos postscript). Además, se pueden adquirir licencias para las 
siguientes opciones: 

 Lista de trabajo de modalidad. 

 PDI. Grabación de CD desde un visor DICOM a Medios de exportación, 
Medios de Importación/Exportación, Consulta de pacientes y Escáner de 
documentos en papel. 

Nuevas funciones de ClinicalExpress 6.1 
 Nuevas opciones de formato de fecha. 
 Soporte para etiquetas de mamografía DICOM Derivadas/Primarias a efectos 

de compatibilidad con los sitios de GE. 
 Soporte para la adquisición de fechas para etiquetas de mamografía a efectos 

de compatibilidad con los sitios de Siemens. 
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Instalación de ClinicalExpress®
 

 

 
 
 

Requisitos del sistema 
 
Para digitalizar y transmitir imágenes usando ClinicalExpress® es necesario 
disponer de un sistema informático, un digitalizador de radiografías VIDAR y 
una conexión de red. 
 
 
Ordenador 
 
El sistema informático mínimo para Windows XP 32 bits SP3 es: 
 PC Pentium 4 a 3.0 GHz 
 2 GB de memoria (para series grandes de imágenes de alta resolución, como 

es el caso de la mamografía, hace falta más memoria) 
 50 GB de espacio disponible en el disco duro 
 
El sistema informático mínimo para Windows 7 Professional de 32 y 64 bits es: 
 PC Dual Core 2 a 1.8 GHz 
 4 GB de memoria (para series grandes de imágenes de alta resolución, como 

es el caso de la mamografía, hace falta más memoria) 
 50 GB de espacio disponible en el disco duro 
 
Vídeo para todos los ordenadores: 
 Tarjeta de vídeo con 16 MB de memoria, con una resolución de 1280 x 1024 y 

64.000 colores o una profundidad de color mayor 
 Pantalla de 20 pulgadas con una resolución de 1280 x 1024 
 
 
Digitalizador de radiografías 
 
ClinicalExpress funciona con la mayoría de los digitalizadores de radiografías 
médicas VIDAR. Contacte con Medtech enviando un correo a 
medtech@3dsysetms.com para saber si su digitalizador es compatible. 
 
ClinicalExpress no funciona con digitalizadores de radiografías de otros 
fabricantes. 
 
 
Conexión de red 
 
Son adecuadas, entre otras, las conexiones de red LAN, WAN, inalámbricas y 
diversos servicios telefónicos. Para que funcione correctamente hace falta el 
protocolo TCP/IP. La explicación detallada de la conexión de red no se 
contempla en el ámbito de este manual. 
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Escáner de documentos opcional 
 
Se puede añadir al sistema un escáner de documentos USB. ClinicalExpress 
funciona con la mayoría de los controladores TWAIN. Para usar un escáner de 
documentos opcional, éste se debe adquirir aparte. Contacte con el Servicio 
Técnico de VIDAR (véase más adelante) para obtener una lista de los escáneres 
probados con el sistema. 
 
 

Escenarios de instalación 
 
Repase los escenarios que figuran a continuación para determinar su situación 
actual y cómo conviene llevar a cabo la instalación de ClinicalExpress 6.0. 
 
 
 Si es la primera vez que instala ClinicalExpress: 

1. Ejecute el archivo ClinicalExpress6.x..exe del CD de ClinicalExpress. 

2. El software funcionará en modo de evaluación durante 30 días. Para 
continuar usando el software después de los 30 días, hace falta una clave de 
licencia (véase “Obtener una clave de licencia para ClinicalExpress” más 
adelante en este mismo capítulo). 

 
 
 Si hay instalada una versión anterior de ClinicalExpress: 

 Si la versión instalada es la 4.x o anterior, contacte con el Servicio Técnico 
de VIDAR (véase más adelante) para obtener las instrucciones de 
actualización. 

 Si tiene instalada la versión 5.0 o superior, puede instalar ClinicalExpress 
6.0 sin necesidad de desinstalar la versión anterior. 

 
 
 

Contacte con el Servicio Técnico de VIDAR si tiene cualquier 
duda sobre la instalación del software ClinicalExpress: 

Teléfono: +1 800 471 SCAN (+1 800 471 7226) 

 +1 703 471 7070 fuera de EE. UU. 

Correo electrónico: medtech@3dsystems.com 
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Descripción general de la instalación 

 
Nota: para poder instalar ClinicalExpress y realizar funciones 
administrativas debe iniciar una sesión como Administrador. Los 
usuarios pueden tener, pero no requieren, derechos administrativos 
en el PC.. Para obtener instrucciones se puede consultar: 
 El tema “Cómo añadir un miembro a un grupo” de la Ayuda  

y Centro de Asistencia de Windows XP. 
 Los temas “Crear una nueva cuenta de usuario” y “Modificar una 

cuenta de usuario” del archivo de ayuda de la ventana 
Administración de equipos de Windows. 

 
La instalación consta de cinco pasos generales: 

A. Instalar y configurar el digitalizador de radiografías. 

B. Ajustar la pantalla. 

C. Instalar el software ClinicalExpress. 

D. Ejecutar ClinicalExpress. 

E. Obtener una clave de licencia de ClinicalExpress. 

 
En los siguientes apartados se explica cada uno de ellos de forma detallada. 
 

Sugerencia: si está creando una nueva estación de trabajo,  
no instale todos los componentes al mismo tiempo. En lugar  
de ello, instale primero el digitalizador de radiografías 
(siguiendo las instrucciones facilitadas con el digitalizador). 
Seguidamente ajuste la pantalla (paso B). Finalmente, instale  
el software ClinicalExpress (paso C) y asegúrese de que el 
sistema funciona. 

 
 
 

A. Instalar y configurar el digitalizador de radiografías 
 
Instale y configure el digitalizador de radiografías y su software siguiendo las 
instrucciones facilitadas con el digitalizador (los detalles de este paso no se 
contemplan en el ámbito de este manual). 
 
 

Nota: en la sección de Atención al cliente del sitio web 
(www.filmdigitizer.com) se pueden descargar las guías de 
instalación y funcionamiento del digitalizador de radiografías 
VIDAR. También puede solicitar los manuales llamando al 
+1 800 471 7226 (+1 703 471 7070 fuera de EE. UU.). 
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B. Ajustar la pantalla 

 
1. Haga clic con el botón derecho en el escritorio y seleccione Propiedades en 

el menú emergente. 
 

  
 

Nota: puede que en su sistema haya un comando específico 
del adaptador de vídeo que sustituya al comando Propiedades. 
Si fuera el caso, haga clic en ese comando. El diálogo de las 
propiedades de pantalla puede ser diferente, pero el objetivo  
es el mismo: ajustar la resolución de la pantalla a un valor igual 
o superior a 1280 x 1024 y la profundidad del color a 16 bits  
o más. 

 
2. En la ventana Propiedades de pantalla, seleccione la pestaña 

Configuración. 
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3. Ajuste el Área de pantalla (o la Resolución de pantalla) a 1280 x 1024  
o más, y los Colores (o la Calidad del color) a Color de alta densidad  
(16 bits) o más. 

 

  
 
4. Pulse Aceptar. 
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C. Instalar el software ClinicalExpress 
 

Nota: si va a actualizar ClinicalExpress 4.x o una versión 
anterior, contacte con el Servicio Técnico de VIDAR enviando 
un correo a medtech@3dsystems.com para obtener 
instrucciones. 

 
Nota: ClinicalExpress se puede instalar en el sistema sin el 
digitalizador de radiografías. Sin embargo, el programa no 
funciona si no hay un digitalizador de radiografías conectado, 
encendido y en comunicación con el ordenador. 

 

1. Inserte el CD de ClinicalExpress en la unidad de CD del ordenador. 
 
2. En Windows Explorer, acceda a la unidad de CD y haga doble clic en 

ClinicalExpress6.x..exe. 
 
3. Siga las instrucciones de la ventana del instalador. 
 
 Durante la instalación se le pedirá que seleccione la GUI predeterminada 

(Radiografía general o Mamografía) que aparece al ejecutar ClinicalExpress. 
Seleccione la GUI más adecuada para su organización (esta opción se puede 
cambiar en la página Administración > Local (Administration > Local) de 
ClinicalExpress). 

 
4. Una vez finalizada la instalación, saque el CD-ROM de la unidad de CD-

ROM. (En el paso E le hará falta la clave que figura en la etiqueta del CD.) 
 
 
 
 

Incorporación de un escáner plano de papel 
 
Se puede instalar un escáner plano de papel para usarlo con ClinicalExpress.  
Siga las instrucciones de instalación del fabricante del escáner. VIDAR ha 
comprobado que los escáneres USB 2.0 normales con controladores TWAIN son 
compatibles con ClinicalExpress. 
 

Nota: en la estación de trabajo de ClinicalExpress solo debe 
instalarse el controlador TWAIN del escáner plano. La 
presencia de cualquier otro controlador TWAIN puede interferir 
con el funcionamiento de ClinicalExpress. Contacte con el 
Servicio Técnico de VIDAR enviando un correo a 
medtech@3dysystems.com para obtener una lista de los 
escáneres que se han probado. 
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D. Iniciar ClinicalExpress 
 

Nota: ClinicalExpress funcionará durante 30 día sin una clave 
de licencia. Para continuar usando ClinicalExpress pasado este 
tiempo, contacte con VIDAR Systems Corporation para obtener 
una clave de licencia (en el siguiente apartado se dan 
instrucciones al respecto). 

 
1. Haga doble clic en el icono de ClinicalExpress del escritorio.  
  o 
 Inicio > Todos los programas > ClinicalExpress. 
 
2. Se abre la ventana Sesión de usuario (User Login): 
 

  
 
3. Use el nombre y la contraseña predeterminados del administrador: 

a. Deje el Nombre de usuario (User Name) como Admin. 
b. Deje la Contraseña (Password) en blanco. 
c. Pulse Aceptar (OK). 

 
4. Si el digitalizador está encendido y correctamente conectado, aparece el 

mensaje siguiente. Pulse Aceptar (OK). 
 

  
 
5. Se ejecuta ClinicalExpress. 
 

Nota: no se pueden digitalizar radiografías mientras no se haya 
definido al menos un destino válido. Consulte el siguiente 
capítulo de este manual: “Configuración de ClinicalExpress”. 
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E. Obtener una clave de licencia de ClinicalExpress 
 

Nota: no se puede obtener una clave de licencia enviando por 
fax el contrato de licencia de ClinicalExpress. Para obtener una 
clave de licencia por correo electrónico, hay que seguir las 
instrucciones que figuran en este apartado. 

 
Para obtener una clave licencia tiene que hacer lo siguiente: 
 
1. Genere un código de referencia y envíelo a VIDAR: 
 

Nota: el código de referencia solo se puede generar si el 
ordenador con ClinicalExpress está conectado a un digitalizador 
de radiografías VIDAR. 

 
a. En la ventana principal de ClinicalExpress, seleccione Archivo > Generar 

código de referencia (File > Generate Reference Code). 
 
b. En el cuadro de diálogo Generar código de referencia (Generate 

Reference Code): 
 Introduzca o modifique los campos Nombre de usuario (User Name), 

Empresa (Company) y País (Country). 
 Introduzca la Clave de CD (CD Key) impresa en la etiqueta del CD de 

instalación de ClinicalExpress. 
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c. Pulse el botón Generar código de referencia (Generate Reference 
Code). 

 

  
 

Nota: el código de referencia es válido durante 15 días. 

 
d. Pulse el botón Guardar (Save) para guardar el código de referencia en un 

archivo en el disco duro local. Guarde el archivo en una ubicación que sea 
fácil de recordar. 

 
e. Pulse el botón Cerrar (Close). 
 
f. Cree un mensaje de correo electrónico nuevo. 
 
g. En el campo Para del mensaje, escriba medtech@3dsystems.com. 
 
h. A continuación: 
 
 Localice el archivo (tiene la extensión .ref) guardado en el paso d 

anterior y adjúntelo al mensaje. 
 
i. Envíe el mensaje. 
 

Nota: mientras espera a que llegue la clave de licencia, puede 
usar ClinicalExpress en el modo de evaluación sin necesidad 
de una clave durante 30 días. Durante el periodo de evaluación 
de 30 días, todas las funciones están habilitadas. 
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2. Cuando haya recibido por correo electrónico la clave de licencia de VIDAR: 
 

a. Guarde el archivo adjunto (con la extensión .key) en el escritorio. 
 
b. Inicie una sesión de ClinicalExpress como administrador. 
 
c. En la ventana principal de ClinicalExpress, seleccione Archivo > Instalar 

licencia (File > Install License). 
 

  
 
d. En el cuadro del diálogo Instalar licencia (Install License): 
 
 Pulse el botón Cargar desde archivo (Load From File), localice el 

archivo de la clave de licencia (con la extensión .key) y ábralo. 
 

  
 
e. Pulse el botón Registrar (Register). 
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f. Si el programa acepta la clave de licencia, se abre la ventana que figura a 
continuación. Pulse Aceptar (OK). 

 

  
 
g. Archivo > Salir (File > Exit). 
 
h. Vuelva a ejecutar ClinicalExpress haciendo doble clic en el icono de 

ClinicalExpress del escritorio. 
 
i. Para comprobar la licencia: Ayuda > Acerca de (Help > About). La 

licencia debe aparecer en la parte superior de la página. Si tiene la licencia 
para Radiografía general y para Mamografía, debe comprobar que aparezca 
en ambas aplicaciones. 

 
3. Vaya al apartado “Configuración de ClinicalExpress”, a continuación en este 

manual, para configurar el programa. 
  o 
 Si necesita configurar ClinicalExpress para imprimir, repase las instrucciones 

de configuración de las impresoras validadas para ClinicalExpress en el 
directorio Printer Specific del CD de instalación de ClinicalExpress. 
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Configuración de 
ClinicalExpress®

 

 

 
 
 

Introducción 
 
En este capítulo se describen las tareas administrativas que se pueden realizar en 
ClinicalExpress: 

 Inicio de sesión en la ventana Administración (Administration). 

 Configuración de los parámetros de la estación de trabajo local. 

 Configuración de los parámetros de presentación. 

 Configuración de las resoluciones del digitalizador. 

 Configuración de las opciones de procesamiento de imágenes. 

 Definición de las vistas de mamografía. 

 Establecimiento de campos de entrada de datos obligatorios. 

 Administración de las cuentas de usuario. 

 Selección de los campos de datos para anonimizar. 

 Copia de seguridad y restablecimiento de la licencia. 

 Definición de destinos. 

 Repaso de la configuración del digitalizador de radiografías. 

 Comprobación de la disponibilidad de listas de trabajo de modalidad. 

 Revisión y gestión del archivo de registro. 

 Calibración del digitalizador de imágenes. 
 
Este capítulo incluye además instrucciones básicas para calibrar el monitor de la 
estación de trabajo. 
 
Si es la primera vez que configura ClinicalExpress, conviene que lea todos los 
apartados de este capítulo y lleve a cabo todas las operaciones aplicables a la 
configuración de su sistema y a las funciones con licencia de ClinicalExpress. 
 

Nota: para poder acceder a la ventana Administración 
(Administration) de ClinicalExpress y efectuar modificaciones, 
debe iniciar una sesión como administrador. 

 
Nota: no se pueden digitalizar radiografías mientras no se haya 
definido al menos un destino válido. Consulte el apartado 
“Definición de destinos” más adelante en este capítulo. 
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Inicio de sesión en la ventana de Administración 
 
La ventana Administración (Administration) de ClinicalExpress está protegida 
por contraseña. 
 
1. Opciones > Administración (Options > Administration). 
 
 Si ya ha iniciado una sesión en ClinicalExpress como administrador, verá la 

ventana de Administración (Administration) y puede ir directamente al paso 
2. En caso contrario, verá la ventana de inicio de sesión: 

 

  
 
2. Introduzca la Contraseña (Password) del administrador y pulse Aceptar 

(OK). 
 
 
 

Ayuda: el nombre 
predeterminado es Admin  
(se distinguen mayúsculas y 
minúsculas) y la contraseña se 
deja en blanco de forma 
predeterminada (deje el  
campo vacío). 
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Configuración de los parámetros de la estación de trabajo 
local 

 
Ajuste los parámetros de la estación de trabajo local en la rama Local del árbol 
de Administración (Administration). 
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Parámetros DICOM 

 

El Título de entidad de aplicación (EA) es el nombre que utilizan otras 
aplicaciones de software para identificar esta aplicación. 

1. Introduzca el Título de entidad de aplicación para este dispositivo DICOM (el 
valor predeterminado de este campo es “ClinicalExpress”). En el Título EA se 
distingue entre mayúsculas y minúsculas. 

2. Introduzca el Número de puerto (Port Number) para este dispositivo 
DICOM (el valor predeterminado de este campo es “207”). 

3. Pulse el botón Aplicar (Apply). 

Registro 
 

 

1. Cambie la configuración del registro como corresponda: 

 Nivel de registro (Log Level): especifica los tipos de información que se 
pueden ver en la ventana Registro de errores (Error Log): 
 INFORMACIÓN (INFORMATION) muestra la información DICOM 

y la información de ClinicalExpress. 
 ADVERTENCIA (WARNING) muestra solamente los errores y las 

advertencias. 
 ERROR muestra solamente los errores. 

 ClinicalExpress captura automáticamente todos los errores y la 
información. (Para ver el registro de errores completo, abra el archivo 
clx.log en un editor de texto.) 

Nota: la ventana Registro de errores (Error Log) no es una 
herramienta de diagnóstico DICOM completa, ya que no 
captura transmisiones DICOM completas. Se usa 
principalmente para solucionar problemas de software. 

 Conservar entradas del registro (Keep Log Entries): las entradas del 
archivo del registro se borran al cabo de este número de días. (Véase 
“Revisión y gestión del archivo de registro” más adelante en este capítulo.) 

2. Pulse el botón Aplicar (Apply). 
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Localización 
 

 
 
1. Seleccione el Idioma (Language) para la interfaz de usuario de la aplicación. 
 
2. Seleccione el Formato de fecha (Date Format) para la aplicación. 
 
3. Pulse el botón Aplicar (Apply). 
 
4 Salga de ClinicalExpress y vuelva a ejecutarlo para hacer efectivos los 

cambios. 
 
 
 
Sistema 
 

 
 
 
1. Cambie la configuración como corresponda (en la imagen superior se indica la 

configuración predeterminada): 
 
 Espacio en disco mínimo (Minimum Disk Space): cuando el espacio 

disponible en disco desciende por debajo de este valor, ClinicalExpress 
borra automáticamente archivos empezando por los estudios más antiguos 
que se han enviado correctamente. Si el programa no puede liberar 
suficiente espacio para alcanzar el valor de Espacio en disco mínimo 
(Minimum Disk Space), no permite que el usuario pueda digitalizar 
radiografías hasta que haya suficiente espacio disponible. 

 
 Longitud máxima de radiografía (Maximum Film Length): 

normalmente se ajusta para radiografías de 43,2 cm de longitud, pero este 
valor se puede cambiar para usar radiografías más largas. 
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Nota: no ajuste la Longitud máxima de radiografía (Max Film 
Length) a un valor superior a 43,2 cm salvo que tenga 
conectado un digitalizador de radiografías DIAGNOSTICPRO® 
Plus o DIAGNOSTICPRO® Advantage. Consulte las instrucciones 
para digitalizar radiografías de más de 43,2 cm de largo en la 
guía de funcionamiento del digitalizador correspondiente. 

 

Nota: como el sistema utiliza una rutina de ajuste automático 
del tamaño para determinar la longitud de la película 
radiográfica, puede que no se puedan digitalizar radiografías 
perforadas. 

 
 Intentos de transmisión (Transmission Retries): especifica el número  

de veces que ClinicalExpress intentará enviar un estudio a un destino. 
ClinicalExpress gestiona las transmisiones de estudios fallidas del siguiente 
modo: 
 Si hay otros estudios en la cola de transmisión, cualquier estudio que no 

se haya podido enviar se coloca al final de la cola y se intenta enviar 
más tarde, sujeto siempre al número de intentos de transmisión y al 
tiempo entre intentos (véase más adelante). 

 Si no hay ningún otro estudio en la cola de transmisión, ClinicalExpress 
intenta reenviar el estudio inmediatamente, sujeto siempre al número de 
intentos de transmisión y al tiempo entre intentos (véase más adelante). 

 Si el estudio no se puede enviar después del número especificado de 
intentos de transmisión, pasa a figurar en la lista de la ventana Estudios 
adquiridos (Acquired Studies) (Ver > Estudios adquiridos (View > 
Acquired Studies)), desde donde se puede iniciar manualmente la 
transmisión. 

 Un estudio que no se pueda enviar (y en tanto no se consiga hacerlo) 
tiene el estado de “fallido”. 

 
 Tiempo entre intentos (Retry Time): especifica el tiempo (en minutos) 

que ClinicalExpress espera antes de intentar enviar un estudio a un destino 
tras fallar el intento previo. 

 
 Primer campo de listas (Lists’ Start Field): especifica si la primera 

columna de la lista de estudios adquiridos y de la lista de procedimientos 
de la lista de trabajo es el Nombre del paciente (Patient Name) o la ID. 

 
 Ruta de imágenes (Images Path): si quiere, puede modificar el directorio 

local predeterminado en el que se guardan las imágenes,  como por 
ejemplo en una partición o una unidad de mayor capacidad. Para cambiar 
la ruta, pulse el botón … y seleccione la nueva ruta. 

 
 Bloquear teclas (Lock Keys): si se marca esta opción, ClinicalExpress 

desactiva las teclas (p. ej., ALT-TAB) que permiten al usuario cambiar de 
ClinicalExpress a otros programas abiertos. 

 
 Habilitar historia adicional (Enable Additional Patient’s History): si se 

marca esta opción, ClinicalExpress muestra el campo Historia adicional 
(Additional Patient History) en la parte inferior de la ventana 
Información del estudio (Study Information). 
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Ventana Información del paciente/estudio/serie 
(Patient/Study/Series Information) sin el campo  
Historia adicional (Additional Patient History) 

Ventana Información del paciente/estudio/serie 
(Patient/Study/Series Information) con el campo  
Historia adicional (Additional Patient History) 

 

 Generación automática del número de registro (Auto Generate 
Accession Number): si se marca esta opción, ClinicalExpress inserta 
automáticamente el siguiente número de registro secuencial en la ventana 
Información del estudio (Study Information) cuando el usuario inicia un 
nuevo estudio. El número de registro insertado se puede editar. 

 
 Enviar número de registro vacío (Send Empty Accession Number): si 

se marca esta opción, ClinicalExpress no envía los números de registro a 
los destinos. 

 
 Enviar ID del tamaño de radiografía (Send Film Size ID): si se marca 

esta opción, ClinicalExpress envía las dimensiones de la radiografía a  
los destinos. 

 
 Enviar cada imagen como una serie (Send each image as a Series): si se 

marca esta opción, cada imagen se envía como una serie. Si no se marca, 
una serie puede incluir múltiples imágenes. 

 
 Configurar tipo de imagen como DERIVADA\PRIMARIA (Set Image 

Type as DERIVED\PRIMARY): si se marca esta opción, las imágenes se 
etiquetan para usarse en sistemas de mamografía de GE. 

 

2. Pulse el botón Aplicar (Apply). 
 
 
 
Desconexión automática (Auto Logout) 
 

 
 
Si se marca esta opción, ClinicalExpress se cierra automáticamente si no detecta 
actividad del usuario (teclado o ratón) durante el tiempo indicado. 
 



 Configuración de ClinicalExpress 30 

19752-001 Rev. E Guía del administrador de ClinicalExpress 6.1 

Después del cambio, pulse el botón Aplicar (Apply). 
 
 
 
Borrar al enviar (Delete After Send) 
 

 
 
Si se marca esta opción, ClinicalExpress elimina a los pacientes o las imágenes 
unos 10 minutos después de haberlos transferido correctamente al destino. 
Consideraciones: 
 Cuando están activadas, estas opciones impiden que el disco de la estación de 

trabajo se sature con archivos de imagen. No obstante, los estudios enviados 
inmediatamente después de la adquisición, y eliminados a continuación, no 
aparecen en la ventana de Estudios adquiridos (Acquired Studies), y por 
tanto no pueden enviarse más tarde al mismo o a cualquier otro destino. 

 Si están desactivadas, estas opciones permiten que los estudios aparezcan en 
la ventana de Estudios adquiridos (Acquired Studies), por lo que pueden 
enviarse más tarde a cualquier otro destino. Sin embargo, los estudios se 
acumulan en el disco de la estación de trabajo y pueden eventualmente saturar 
su capacidad. 

 La base de datos de ClinicalExpress tiene una capacidad máxima de 10 GB. Si 
se alcanza este límite, para poder continuar digitalizando radiografías deben 
eliminarse imágenes y pacientes. 

 
Después del cambio, pulse el botón Aplicar (Apply). 
 
 
 
Borrar tras compromiso de almacenamiento (Delete After 
Storage Commitment) 
 

 
 
Si se marca esta opción, ClinicalExpress solo elimina a los pacientes o imágenes 
tras recibir el mensaje de compromiso de almacenamiento del destino. El 
mensaje confirma no solo que el destino ha recibido la transmisión, sino también 
que la ha almacenado. (Consultar las consideraciones en el apartado “Borrar al 
enviar” anterior.) 
 
Después del cambio, pulse el botón Aplicar (Apply). 
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GUI inicial predeterminada (Default Startup GUI) 
 

 
 
Esta opción especifica el modo de presentación al iniciar ClinicalExpress. Si se 
han adquirido licencias para Radiografía general y Mamografía, los usuarios 
pueden cambiar de un modo a otro. 
 
Después del cambio, pulse el botón Aplicar (Apply). 
 
 
 
Autocompletar estudio (Auto Fill Study) 
 

 
 
Si se marca esta opción, se introducen automáticamente la fecha y la hora 
actuales en los nuevos estudios. 
 
Después del cambio, pulse el botón Aplicar (Apply). 
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Configuración de los parámetros de presentación 
Ajuste los parámetros de presentación en la rama Local | Configuraciones  
de presentación (Local | Display Settings) del árbol de Administración 
(Administration). 

 

Configuraciones de presentación preestablecidas 
 
Las configuraciones de presentación aplican automáticamente a una imagen los 
ajustes de ventana y nivel correspondientes en función de la parte del cuerpo y la 
modalidad seleccionadas por el usuario. Los ajustes se basan en el tipo de 
película radiográfica, el tipo de digitalizador y la profundidad en bits. En la 
pantalla superior se muestran cuatro configuraciones de presentación 
preestablecidas. Esta sección de la ventana Administración (Administration) 
permite definir, modificar y eliminar configuraciones de presentación. 
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 Para crear una nueva configuración de presentación: 
 

a. Pulse el botón Nueva (New). 
 
b. Haga clic en el campo Modalidad (Modality) e introduzca la modalidad. 

 o 
Seleccione una modalidad de la lista. 

 
c. Haga clic en el campo Vista (View) e introduzca la vista. 
  o 
 Seleccione una vista de la lista. 
 
d. Introduzca los datos de ventana y nivel de una profundidad en bits. 

ClinicalExpress calcula y rellena automáticamente los valores 
correspondientes de las otras dos profundidades en bits. 

 

  

Ventana Nivel 
 

 

Ventana Nivel 
 
e. Pulse el botón Guardar (Save). 

 
Nota: ClinicalExpress ha precalculado los ajustes de ventana y 
nivel para la Parte del cuerpo (Body Part) = 
PREDETERMINADA y la Modalidad (Modality) = 
PREDETERMINADA. Estos son los ajustes que se aplican 
inicialmente a las imágenes. El usuario los puede reemplazar 
usando la herramienta para configurar la ventana y el nivel con 
el ratón, o bien introduciendo valores en los campos Ventana 
(Window) y Nivel (Level) de la ventana principal o usando los 
valores de ventana/nivel preestablecidos. El administrador 
puede modificar las configuraciones predeterminadas (en la 
lista de la izquierda) como se describe a continuación. 
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 Para cambiar los valores de ventana y nivel de una configuración de 
presentación: 

 
a. Pulse en la fila que desee cambiar. 
 
b. Pulse el botón Editar (Edit). 
 
c. Modifique el valor de la ventana (campo izquierdo) o el nivel (campo 

derecho) de una profundidad en bits. ClinicalExpress calcula y rellena 
automáticamente los valores correspondientes de las otras dos 
profundidades en bits. 

 
d. Pulse el botón Guardar (Save). 

 
 
 Para eliminar una configuración de presentación: 
 

a. Pulse en la fila que desee eliminar. 
 
b. Pulse el botón Eliminar (Delete). 

 
 
 Para aplicar automáticamente los ajustes de ventana y nivel en función del 

tamaño de la radiografía y de la resolución de la imagen: marque la casilla 
Habilitar ventana/nivel automáticos (Enable Auto Window/Level). 
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Configuración de las resoluciones del digitalizador 
 
Ajuste las resoluciones del digitalizador en la rama Local | Configuraciones del 
digitalizador (Local | Digitizer Settings) del árbol de Administración 
(Administration). 
 

 
 
 
Las configuraciones del digitalizador ajustan automáticamente la resolución de la 
imagen en función del ancho de la película radiográfica. 
 
 Para cambiar una resolución: 
 

a. Pulse en la fila que contiene el tamaño de radiografía que desea modificar. 
 
b. Haga doble clic en la columna Resolución (Resolution) de esa fila. 
 
c. Selección la resolución correspondiente. 
 
d. Pulse el botón Guardar (Save). 
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Configuración de las opciones de procesamiento  
de imágenes 

 
Ajuste las opciones de procesamiento de imágenes en la rama Local | 
Procesamiento de imágenes (Local | Image Processing) del árbol de 
Administración (Administration). 
 

 
 
 

Nota: las configuraciones predeterminadas de la ventana 
Procesamiento de imágenes (Image Processing) están 
desactivadas. 
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Nota: ClinicalExpress aplica de manera automática y 
permanente a cada imagen las operaciones de procesamiento 
de imágenes marcadas en cuanto las adquiere del digitalizador 
(y, por consiguiente, antes de presentarlas o enviarlas). Los 
usuarios no pueden deshacer los resultados del procesamiento 
de imágenes. Si las imágenes no se tienen que procesar, es 
necesario que el administrador desactive las opciones de la 
página Procesamiento de imágenes (Image Processing) y 
que el usuario vuelva a digitalizar las radiografías para obtener 
nuevas imágenes. 

 
1. Configure las opciones de procesamiento de imágenes como corresponda: 
 
 Máscara de desenfoque (Unsharp Mask): si se marca esta opción, 

ClinicalExpress aplica un algoritmo de máscara de desenfoque para 
aumentar la nitidez de la imagen. Seleccione Baja (Low), Media 
(Medium) o Alta (High) para controlar el grado de nitidez. 

 
 DRC (compresión de la gama dinámica): si se marca esta opción, 

ClinicalExpress aplica un filtro no lineal para comprimir la gama dinámica 
de la imagen. Seleccione Baja (Low), Media (Medium) o Alta (High) 
para controlar el grado de compresión. 

 
 Procesamiento posdigitalización (Post-Digitization Processing): 
 Enderezar imagen tras la digitalización (Straighten Image After 

Digitization): si se marca esta opción, las imágenes que sobrepasan el 
Valor umbral (Threshold Value) se enderezan automáticamente 
después de la captura. Si no se marca, el usuario puede enderezar las 
imágenes en la ventana de ClinicalExpress. 

 Valor umbral (Threshold Value): para que se enderece 
automáticamente, la rotación de la imagen debe ser mayor que  
este valor. 

 Restablecer (Reset): pulse este botón para restablecer los valores  
de umbral predeterminados. 

 
Nota: para enderezar automáticamente las imágenes se asume 
que los bordes de la radiografía son rectos y forman ángulos 
rectos entre sí. Desactive esta opción si se ha cortado la 
radiografía. 

 
 TB de monitor (Monitor LUT): si se marca esta opción, ClinicalExpress 

aplica los valores de la tabla de búsqueda a la imagen antes de 
representarla. 
 Desde archivo (From File): seleccione esta opción si la tabla de 

búsqueda está disponible como un archivo. Introduzca la ruta y el 
nombre del archivo o pulse el botón de examinar para seleccionar el 
archivo. 

 Generar usando la densidad (Generate Using Density): seleccione 
esta opción para que ClinicalExpress genere una tabla de búsqueda 
basada en el valor de densidad especificado. 
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 Aplicar FVE (Apply SDF): si se marca esta opción, ClinicalExpress 
aplica a la imagen los valores de la función de visualización estándar antes 
de presentarla, y para ello usa los valores de Iluminación (Illumination), 
Luz ambiental (Ambient Light), DMin (densidad mínima del 
digitalizador) y DMax (densidad máxima del digitalizador) especificados. 

 
2. Pulse el botón Aplicar (Apply). 

Valores de FVE DICOM 
predeterminados 

Iluminación 2000 cd/m2 

Luz ambiental 10 cd/m2 

DMin 0 

DMax 255 
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Definición de las vistas de mamografía 
Las vistas proporcionan a los usuarios de ClinicalExpress protocolos de clasificación 
para organizar imágenes mamográficas independientes en determinadas 
composiciones. ClinicalExpress viene con un protocolo de 2 x 2 predeterminado.  
El usuario puede definir otras vistas en función de sus necesidades. 

Nota: la opción de escaneado de documentos para 
mamografía es una función añadida en ClinicalExpress 6.0. Si 
no dispone de la opción PDI, es necesario añadirla para poder 
escanear documentos con un escáner plano. También es 
necesario definir un diseño para trasladar la Vista radiográfica 
(Film View) a PAPEL (PAPER). 

Defina las vistas en la rama Local | Mamografía (Local | Mammography) del 
árbol de Administración (Administration). 
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1. Pulse el botón Nueva (New). 
 
2. En la lista Vistas (Views), haga clic en la columna Nombre (Name), 

introduzca un nombre para el diseño y pulse ENTRAR. 
 

 
 
3. Abra la lista Diseño (Layout) y haga clic en el diseño de filas x columnas 

correspondiente. 
 
4. En la lista Orden de vistas (View Order), especifique la Vista radiográfica 

(Film View) de cada celda. La Vista previa del diseño (Layout Preview) 
muestra cómo se asignan las vistas radiográficas a las celdas. 

 

  
 
 

Nota: para escanear documentos, configure la Vista 
radiográfica (Film View) como PAPEL (PAPER). 

 
Nota: la Orientación del paciente (Patient Orientation) se 
ajusta automáticamente al seleccionar una Vista radiográfica 
(Film View), y no se debe modificar. 

 
Nota: los usuarios pueden modificar aquí la Orientación del 
paciente (Patient Orientation) predeterminada. 

 
 
 Para eliminar una vista: 

a. En la lista de Vistas (Views), haga clic en la vista y pulse después el botón 
Eliminar (Delete). 

b. Confirme la eliminación. 
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 Para editar una vista: 
a. En la lista de Vistas (Views), haga clic en la vista y pulse después el botón 

Editar (Edit). 
b. En la lista de Vistas (Views), haga clic en el Nombre (Name) e introduzca 

un nuevo nombre. 
c. En la lista Orden de vistas (View Order), cambie la Vista radiográfica 

(Film View) y la Orientación del paciente (Patient Orientation) como 
corresponda. 

d. Pulse el botón Guardar (Save). 
 

Nota: una vista solo se puede eliminar o modificar si no hay 
ningún estudio que haga referencia a ella. 

 
 
Entender las vistas y las orientaciones del paciente 
 
El siguiente ejemplo muestra las relaciones entre las vistas, las imágenes y las 
orientaciones del paciente. 
 
Suponga que se definen las dos vistas siguientes: 
 
Vista A 

Fila Columna Vista 
radiográfica 

Orientación del 
paciente 

1 1 CCD PC 

1 2 CCI AC 

2 1 MLOD ACI 

2 2 MLOI PCI 

 
Vista B 

Fila Columna Vista 
radiográfica 

Orientación del 
paciente 

1 1 CCD CI 

1 2 CCI PC 

2 1 MLOD PCI 

2 2 MLOI CD 

 
A las imágenes dispuestas en las celdas se les asignan las orientaciones del 
paciente predeterminadas. Supongamos que se está usando la Vista A. La imagen 
situada en la fila 1 - columna 1 (CCD) tendrá la orientación PC predeterminada. 
 
Supongamos ahora que el usuario hace clic con el botón derecho en una imagen, 
cambia su orientación a PC y la arrastra hasta la fila 2 - columna 2 (MLOI). Esta 
imagen anula la orientación PCI predeterminada y conserva la orientación PC 
asignada por el usuario. 
 
Imaginemos ahora que el usuario selecciona la Vista B de este mismo estudio. 
Esta acción aplica a las imágenes las orientaciones del paciente predeterminadas 
de la Vista B. La imagen correspondiente a CCD, por ejemplo, tiene ahora la 
orientación CI. 
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Supongamos que el usuario cierra el estudio. A continuación usted (como 
administrador) edita la Vista B, y cambia a AC la orientación del paciente 
correspondiente a CCD. Si el estudio se vuelve a abrir, la imagen CCD tiene la 
orientación del paciente CI (guardada con el estudio al cerrarlo), no AC (la nueva 
orientación predeterminada para la celda CCD). Sin embargo, si se añade una 
nueva imagen a la celda CCD, se le asigna la orientación AC predeterminada. 
 
Creación de códigos de vista personalizados y códigos de 
modificador de vista personalizados 
 
Se pueden crear códigos de vista personalizados para incluirlos en la lista 
desplegable de la columna Vista radiográfica (Film View) de la lista Orden de 
vistas (View Order) de la rama Local | Mamografía (Local | Mammography) 
del árbol de Administración (Administration) (descrito anteriormente en esta 
sección). También se pueden crear códigos de modificador de vista 
personalizados asociados con los códigos de vista personalizados. 
 

Nota: cuando se publicó este manual, DICOM e IHE no habían 
definido códigos de vista personalizados ni códigos de 
modificador de vista personalizados. El desarrollo, uso y 
fiabilidad de los códigos de vista personalizados y códigos de 
modificador de vista personalizados es responsabilidad 
exclusiva del usuario de ClinicalExpress. 

 
 Para crear un código de vista personalizado: 

1. En la rama Local | Mamografía (Local | Mammography) del árbol de 
Administración (Administration), pulse el botón Personalizado 
(Custom). Esto abre la ventana Personalizar vistas de mamografía 
(Customize Mammography Views) (véase la página siguiente). 

2. En la sección Códigos de vista personalizados (Custom View Codes), 
pulse el botón Nuevo (New). 

3. Haga clic en cada columna y rellene la información asociada. 
4. Pulse Guardar (Save). 
 

 Para editar un código de vista personalizado: 
1. En la sección Códigos de vista personalizados (Custom View Codes), 

haga clic en el código de vista que desee editar. 
2. Pulse Editar (Edit). 
3. Cambie la información que corresponda. 
4. Pulse Guardar (Save). 
 

 Para eliminar un código de vista personalizado: haga clic en el código de 
vista que desee eliminar y pulse Eliminar (Delete). 

 
Nota: un código de vista personalizado solo se puede editar o 
eliminar si no hay ningún diseño de vista que haga referencia al 
mismo. 

 
 Para crear un código de modificador de vista personalizado: 
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1. En la sección Código de modificador de vista personalizado (Custom 
View Modifier Code), pulse el botón Nuevo (New). 

2. Haga clic en cada columna y rellene la información asociada. 
3. Pulse Guardar (Save). 
 

 Para editar un código de modificador de vista personalizado: 
1. En la sección Códigos de modificador de vista personalizados (Custom 

View Modifier Codes), haga clic en el código de modificador de vista que 
desee editar. 

2. Pulse Editar (Edit). 
3. Cambie la información que corresponda. 
4. Pulse Guardar (Save). 
 

 Para eliminar un código de modificador de vista personalizado: haga clic en 
el código de modificador de vista que desee eliminar y pulse Eliminar 
(Delete). 

 
Nota: un código de modificador de vista personalizado solo se 
puede editar o eliminar si no hay ningún código de vista 
personalizado que haga referencia al mismo. 

 
Nota: durante el almacenamiento y la exportación DICOM, los 
códigos de vista personalizados se añaden al encabezado de la 
imagen DICOM como una secuencia de códigos de vista (0054, 
0222). Todos los códigos de modificador de vista se envían 
como una secuencia de códigos de modificador de vista (0054, 
0220) que es parte de la secuencia de códigos de vista. 
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Establecimiento de campos de entrada de datos obligatorios 
 
Los campos de entrada de datos de las ventanas Información del paciente 
(Patient Information) e Información del estudio (Study Information) se 
pueden establecer como obligatorios (lo cual se indica con los nombres en 
negrita) conforme a las políticas de su organización. 
 
Establezca los campos de datos obligatorios en la rama Local | Campos 
obligatorios (Local | Mandatory Fields) del árbol de Administración 
(Administration). 
 

 
 
 
1. Establezca los campos obligatorios como corresponda: 
 
 Para que el usuario tenga que rellenar un campo obligatoriamente: 

marque la casilla de la columna Obligatorio (Mandatory). 
 
 Para hacer que un campo sea opcional: desactive la casilla de la columna 

Obligatorio (Mandatory). 
 
2. Pulse el botón Aplicar (Apply). 
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Administración de las cuentas de usuario 
 
El Administrador de usuarios (User Manager) permite al administrador de 
ClinicalExpress agregar, modificar y eliminar cuentas de usuario. 
 

Nota: todos los usuarios de ClinicalExpress deben tener 
asignados privilegios de usuario avanzado en Windows 2000 o 
Windows XP. 

 
Las cuentas de usuario se añaden, editan o eliminan en la sección Local | 
Administrador de usuarios (Local | User Manager) de la ventana 
Administración (Administration). Las instrucciones comienzan en la página 
siguiente. 
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 Para añadir una cuenta de usuario: 
 

a. Pulse el botón Añadir (Add). Esto abre la ventana de Información de 
usuarios (User Information). 

 

  
 
b. Introduzca el Nombre de usuario (User Name) (es decir, el nombre de 

inicio de sesión), el Nombre completo (Full Name) y la Descripción 
(Description) (p. ej., cargo) del nuevo usuario. Introduzca una Contraseña 
(Password) para el usuario, y vuelva a introducir la misma contraseña en 
el campo Confirmar contraseña (Confirm Password). 

 
c. Pulse Crear (Create). 
 
 

 Para cambiar el nombre completo, la descripción o la contraseña de un 
usuario: 
 
a. En la lista de usuarios, pulse en la fila de la cuenta del usuario. 
 
b. Pulse el botón Editar (Edit). 
 

  
 
c. Cambie la información que corresponda. 
 
d. Pulse Guardar (Save). 
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Nota: el nombre de inicio de sesión (Nombre de usuario (User 
Name)) del usuario no se puede cambiar. Para cambiar el 
nombre de usuario, elimine la cuenta y cree una cuenta de 
usuario nueva como se describe en este apartado. 

 
Nota: la contraseña del administrador se puede cambiar, pero 
su nombre de usuario no. Guarde la contraseña del 
administrador en un lugar seguro. 

 
 

 Para borrar una cuenta de usuario: 
 
a. En la lista de usuarios, pulse en la fila de la cuenta del usuario. 
 
b. Pulse el botón Borrar (Remove). 

 
Nota: la cuenta de usuario “Admin” no se puede eliminar. 

 
 
 
Las contraseñas no se pueden recuperar. Si un usuario olvida su contraseña, hay 
que borrar su cuenta y crear una cuenta nueva para el usuario. 
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Selección de los campos de datos para anonimizar 
 
Para preservar la intimidad del paciente, los datos de determinados campos se 
pueden anonimizar (eliminar o sustituir por valores fijos) al enviar los estudios a 
un destino. Al aplicar la anonimización durante la transmisión, no se modifican 
los datos originales guardados en la base de datos de ClinicalExpress. 
 
El proceso de configuración para anonimizar datos tiene dos pasos: 
1. Especificar los campos que se van a anonimizar (descrito en este apartado). 
2. Activar la opción Anonimizar (Anonymize) para los destinos (descrito en el 

siguiente apartado de este capítulo: “Definición de destinos”). 
 
Los campos anónimos se añaden, modifican o eliminan en la sección Local | 
Anonimizar (Local | Anonymize) de la ventana Administración 
(Administration). 
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 Para designar un campo como anónimo: 
 

a. Pulse el botón Añadir (Add). Esto abre la ventana de Información de 
elementos del anonimizador (Anonymizer Element Information). 

 

  
 
b. Abra la lista Nombre (Name) y haga clic en el campo que se va a 

anonimizar. Puede anonimizar los siguientes campos: 
 Nombre del paciente 

(Patient Name) 
 ID de paciente (Patient ID) 
 Fecha de nacimiento  

(Birth Date) 
 Sexo del paciente  

(Patient Sex) 
 Número de registro 

(Accession Number) 
 Fecha del estudio  

(Study Date) 
 Hora del estudio  

(Study Time) 
 Descripción del estudio 

(Study Description) 
 Descripción de la serie 

(Series Description) 
 

 Descripción del diagnóstico en 
admisión (Admitting Diagnosis 
Description) 

 Nombre del médico remitente 
(Referring Physician Name) 

 Nombre del centro  
(Institution Name) 

 Modalidad (Modality) 
 Fabricante (Manufacturer) 
 ID de estudio (Study ID) 
 Número de serie (Series Number) 
 Número de instancia  

(Instance Number) 
 Tipo de conversión  

(Conversion Type) 
 Parte del cuerpo examinada 

(Body Part Examined) 

 
c. Opcional: introduzca un Valor (Value) para reemplazar los datos del 

paciente. Si no se introduce ningún valor, el campo anónimo se deja  
en blanco. 

 
d. Pulse Aceptar (OK). 

 
 
 Para editar los valores de anonimización de un campo: 
 

a. Pulse en la fila del campo que se va a modificar. 
 

b. Pulse el botón Editar (Edit). 
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c. Cambie el Valor (Value) en la ventana de Información de elementos del 
anonimizador (Anonymizer Element Information). 

 

d. Pulse Aceptar (OK). 
 
 

 Para borrar la anonimización de un campo: 
 

a. Pulse en la fila que se va a borrar. 
 

b. Pulse el botón Borrar (Remove). 
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Copia de seguridad y restablecimiento de la licencia 
 
Las instalaciones de ClinicalExpress tienen la opción de hacer una copia de 
seguridad de la licencia. Se recomienda configurar esta función poco después de 
instalar ClinicalExpress, ya que permite guardar la clave de licencia en un lugar 
seguro, como por ejemplo un directorio de red o un lápiz de memoria (memoria 
USB), para poder restaurar la licencia en el caso de que se produjera un problema 
de hardware o software en el ordenador. 
 
El archivo de copia de seguridad de la licencia registra el número de escaneados 
que quedan y el límite de tiempo de la licencia. Este archivo se vuelve a crear 
con los datos del último escaneado y la hora cada 24 horas sobrescribiendo la 
copia anterior (por ese motivo no se puede hacer la copia de seguridad en un CD 
o un DVD). Si ClinicalExpress no está funcionando a la hora programada de una 
copia de seguridad, la copia se realiza la siguiente vez que se inicia la aplicación. 
 

Copia de seguridad de la licencia 
 
Haga una copia de seguridad de la licencia en la sección Local | Copia de 
seguridad de la licencia (Local | License Backup) de la ventana de 
Administración (Administration). 
 

 

 Para hacer una copia de seguridad de la licencia: 
 

a. Active la opción Habilitar copia de seguridad de la licencia (Enable 
License Backup). 

b. Pulse el botón Más (More)  y seleccione la ubicación donde desea 
guardar la licencia. 

 
Nota: no seleccione una ubicación del ordenador local. 
Seleccione un directorio de red, un lápiz de memoria que esté 
siempre conectado al ordenador o una ubicación similar que no 
se vea afectada si el ordenador local tiene algún problema o es 
necesario cambiarlo. 

c. Pulse el botón Copia de seguridad de la licencia (Backup License). 
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Restaurar la licencia 

 
Si hay algún problema de hardware o software en el ordenador donde se ejecuta 
ClinicalExpress, y se ha activado la opción de copia de seguridad de la licencia 
(descrita en la página anterior), VIDAR puede restaurar la licencia. 
 
1. Cree un mensaje de correo electrónico nuevo. 
 
2. En el campo Para del mensaje, escriba medtech@3dsystems.com. 
 
3. Localice el archivo de copia de seguridad de la licencia (tendrá la extensión 

.ref) y adjúntelo al mensaje. 
 
4. En el cuerpo del mensaje, describa la situación y solicite el restablecimiento 

de la licencia. 
 
5. Envíe el mensaje. 
 
6. Cuando reciba la respuesta con la licencia restaurada, instale la licencia como 

se describe en el paso 2 del apartado “E. Obtener una clave de licencia de 
ClinicalExpress” del capítulo “Instalación de ClinicalExpress” de este manual. 

 
Si no puede proporcionar una copia de la licencia, tendrá que adquirir una 
licencia nueva. 
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Definición de destinos 
 
Los administradores pueden configurar, modificar y eliminar parámetros de 
destinos y dispositivos remotos. Un destino es un punto al que se envían estudios 
o un punto de origen de datos de Listas de trabajo de modalidad (la opción de 
Lista de trabajo de modalidad se adquiere por separado). 
 
Los destinos se gestionan en la rama Destinos (Targets) del árbol de 
Administración (Administration). 
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Creación de un nuevo destino 
 
1. Pulse el botón Nuevo (New). Esto despliega la página Nuevo destino  

(New Target). 
 

  
 
2. En la sección Destino (Target): 
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a. Introduzca el Nombre (Name) del destino. Conviene que sea un nombre 
claro y conciso, como por ejemplo “Clínica” o “Dra. Rol”. Use nombres 
que los usuarios no puedan confundir. 

 
Nota: después de introducir el nombre y guardar el destino, el 
nombre ya no se puede cambiar. Para cambiar el nombre es 
necesario eliminar el destino y crear uno nuevo. 

 
b. Seleccione el Tipo (Type) de destino. Las opciones son: 
 ALMACENAMIENTO DICOM (DICOM STORE) 
 COMPROMISO DE ALMACENAMIENTO (STORAGE 

COMMITMENT) 
 PASO DE PROCEDIMIENTO REALIZADO EN MODALIDAD 

(MODALITY PERFORMED PROCEDURE STEP) 
 IMPRESORA DICOM (DICOM PRINTER) 
 IMPRESORA POSTSCRIPT (POSTSCRIPT PRINTER) 
 CD DICOM (DICOM CD) 
 LISTA DE TRABAJO DE MODALIDAD (MODALITY WORK LIST) 
 CONSULTA DE PACIENTES DICOM (DICOM PATIENT QUERY) 

 
Nota: el campo Tipo (Type) determina los campos que se 
pueden cambiar en las secciones de la izquierda de la ventana 
Nuevo destino (New Target), así como los campos que 
aparecen en la sección de la derecha (Configuración 
(Configuration)). 

 
c. (Opcional) Introduzca una Descripción para el destino. 
 
d. Para designar este destino como el predeterminado: marque la opción 

Predeterminado (Default). La información del destino predeterminado se 
indica en la sección Destino (Target) de la ventana principal de 
ClinicalExpress cuando se inicia el programa y cuando el usuario pulsa el 
botón Destino predeterminado (Default Target). 

 
Sugerencia: si la estación de trabajo va a enviar estudios a un 
único destino o al mismo destino la mayoría de las veces, 
configure ese destino como predeterminado. 

 
e. Para anonimizar los datos enviados a este destino: marque la opción 

Anonimizar (Anonymize). Los campos para anonimizar se seleccionan en 
la ventana Local | Anonimizar (Local | Anonymize) (consulte el apartado 
anterior de este capítulo: “Selección de los campos de datos para 
anonimizar”). 

 
f. Para permitir la compresión sin pérdida JPEG estándar: marque la casilla 

Permitir compresión sin pérdida (Allow Lossless Compression). 
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3. En la sección Comunicación (Communication): 
 

  
 

a. Introduzca el Título EA (AE Title) (título de la entidad de aplicación) del 
destino remoto. En los Títulos EA se distingue entre mayúsculas y 
minúsculas. 

 
b. Introduzca el Tamaño de PDU (PDU Size) (tamaño de la unidad de datos 

de protocolo) del destino en bytes. Este parámetro especifica el tamaño de 
bloque máximo que el destino puede recibir de ClinicalExpress. 

 
Nota: los parámetros Título EA (AE Title) y Tamaño de PDU 
(PDU Size) normalmente los define el programa receptor. 

 
c. Introduzca el Tiempo de espera de respuesta (Response Timeout) 

necesario en minutos. Este es el período de tiempo que ClinicalExpress 
espera por una respuesta después de enviar una comunicación al destino. 
Un tráfico de red intenso ralentiza el funcionamiento de ClinicalExpress. 
El valor máximo es de 5 minutos. Para especificar un tiempo de espera 
infinito, introduzca el valor 0. 

 
d. Introduzca el número de Puerto (Port) de la aplicación receptora (p. ej., 

104, 4006). 
 
e. Introduzca el Nombre de host (Host Name) o la dirección IP de la 

aplicación receptora. 
 
f. Si se va a acceder al destino a través de una conexión de acceso telefónico, 

marque la casilla Acceso telefónico (Dial-up), e introduzca la información 
correspondiente. 
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4. La sección Digitalizador (Digitizer) permite configurar la profundidad en bits 
y la resolución predeterminadas, y especificar si los usuarios pueden 
reemplazar estos valores predeterminados. La Profundidad en bits (Bit 
Depth) predeterminada es 16, y la Resolución (Resolution) predeterminada 
es 570. En la sección Digitalizador (Digitizer): 

 

  
 

a. Para permitir establecer la resolución en función del tamaño de la 
radiografía: marque la opción Resolución definida por la radiografía 
(Set Film Size Based Resolution). 

 
b. Para cambiar la profundidad en bits y la resolución predeterminadas: 

marque la opción Habilitar profundidad en bits y resolución (Enable 
Bit Depth and Resolution) e introduzca los valores de Profundidad en 
bits (Bit Depth) y Resolución (Resolution) correspondientes. (Los valores 
disponibles dependen del digitalizador conectado.) 

 
c. Para permitir que los usuarios reemplacen la profundidad en bits y la 

resolución predeterminadas: active (o deje activada) la opción Habilitar 
profundidad en bits y resolución (Enable Bit Depth and Resolution). 
Consideraciones: 
 Desactive la opción Habilitar profundidad en bits y resolución 

(Enable Bit Depth and Resolution) si el destino tiene que recibir las 
imágenes capturadas con una profundidad en bits y una resolución 
específicas. Esta es la configuración recomendada si no se está usando 
la opción de Resolución definida por la radiografía (Set Film Size 
Based Resolution). 

 Active la opción Habilitar profundidad en bits y resolución (Enable 
Bit Depth and Resolution) si el destino puede recibir imágenes 
capturadas con cualquier profundidad en bits y resolución disponibles, y 
los usuarios de ClinicalExpress tienen la formación necesaria para 
seleccionar los ajustes apropiados para el estudio y el destino. 

 
Nota: es responsabilidad del centro asegurarse de que la 
profundidad en bits y la resolución de las imágenes y estudios 
con los que se va a utilizar ClinicalExpress son clínicamente 
adecuadas. 
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5. Las opciones de la sección Configuración (Configuration) dependen del 
Tipo (Type) de destino seleccionado. Siga las instrucciones para el Tipo 
(Type) de destino seleccionado: 

 
 
 Para el Tipo (Type) de destino ALMACENAMIENTO DICOM (DICOM 

STORE): 
 

  
 

a. Si hay una tabla de búsqueda disponible para el destino, marque la 
casilla TB (LUT) y pulse el botón ... (indicado por la flecha) para 
seleccionar el archivo de TB. 

 
b. Si ClinicalExpress tiene que responder a los mensajes de compromiso 

de almacenamiento de un destino: 
 Active la casilla Compromiso de almacenamiento (Storage 

Commitment). 
 Seleccione un Destino (Target), o bien Mismo (Same) para aplicar 

esta opción al destino actual. 
 Introduzca un Tiempo de espera máximo (Maximum Wait Time). 

ClinicalExpress no hará nada salvo que reciba un compromiso de 
almacenamiento dentro de este período de tiempo. 

 
 
 Para el Tipo (Type) de destino COMPROMISO DE 

ALMACENAMIENTO (STORAGE COMMITMENT): 
 

  
 
 Introduzca un Tiempo de espera máximo (Maximum Wait Time). 

ClinicalExpress no hará nada salvo que reciba un compromiso de 
almacenamiento dentro de este período de tiempo. 

 
 
 Para el Tipo (Type) de destino PASO DE PROCEDIMIENTO 

REALIZADO EN MODALIDAD (MODALITY PERFORMED 
PROCEDURE STEP), no hay opciones de configuración. 
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 Para el Tipo (Type) de destino IMPRESORA DICOM (DICOM 
PRINTER): 

  

a. Si hay una tabla de búsqueda disponible para la impresora, active la 
casilla TB (LUT) y pulse después el botón ... (indicado por la flecha) 
para seleccionar el archivo de la TB. Las TB disponibles están en el 
directorio específico de las impresoras del CD de instalación de 
ClinicalExpress. 

b. Si no hay una tabla de búsqueda disponible para la impresora, active la 
casilla Aplicar FVE (Apply SDF) (función de visualización estándar) 
y, a continuación: 
 Configure el Tipo de impresora (Printer Type) para que coincida 

con la impresora DICOM. 
 Establezca el Tipo de transformación (Transformation Type) en 

SCP (la impresora aplica la FVE a la imagen) o en SCU 
(ClinicalExpress aplica la FVE a la imagen). Para que el Tipo de 
transformación (Transformation Type) sea válido, la impresora 
DICOM debe ser compatible con la clase de SOP de la TB de 
presentación (compruebe los detalles en el manual de la impresora); 
esto lo negocia el software durante la fase de asociación. 

 Si se activa la casilla Aplicar FVE a la imagen aunque sea 
incompatible con la impresora (Apply SDF on image even if not 
supported by printer), y la impresora no admite la clase SOP de 
presentación (compruebe el manual de la impresora), 
ClinicalExpress genera los valores de la FVE (basándose en los 
campos Iluminación (Illumination) y Luz ambiental (Ambient 
Light)) y aplica una TB antes de enviarla a la impresora. 
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 Introduzca los valores de Iluminación (Illumination) (luminancia 
debida a la iluminación) y Luz ambiental (Ambient Light) 
(luminancia debida a la luz ambiental) para usar en el cálculo de la 
FVE. Los valores predeterminados de DICOM son: 

 Medio de transmisión 
(película) 

Medio de reflexión 
(papel) 

Iluminación 2000 cd/m2 150 cd/m2 

Luz ambiental 10 cd/m2 0 cd/m2 

 
c. En la sección Configuración (Settings): 
 Ajuste la Ampliación (Magnification) como corresponda. Las 

opciones son: 
 Réplica (Replicate) (cada píxel de la impresora representa un 

píxel de la imagen). 
 Ninguna (None) (ajusta la imagen al tamaño medio de la 

impresora sin volver a interpolar). 
 Bilineal (Bilinear) (ajusta la imagen al tamaño medio de la 

impresora usando una interpolación bilineal). 
 Cúbica (Cubic) (ajusta la imagen al tamaño medio de la 

impresora usando una interpolación cúbica). 
 Establezca la Orientación de la radiografía (Film Orientation) en 

Vertical (Portrait) (borde más largo en vertical) u Horizontal 
(Landscape) (borde más largo en horizontal). 

 Seleccione el medio del destino: Película azul (Blue Film), Película 
transparente (Clear Film) o Papel (Paper). 

 Ajuste el Tamaño de la radiografía (Film Size) en pulgadas. 
 Ajuste los valores de DMin (opacidad mínima de la película) y 

DMax (opacidad máxima de la película). 
 Active la opción Tamaño real (True Size) para imprimir con la 

misma relación de aspecto de la radiografía original. Si no se activa 
esta opción, la relación de aspecto de la imagen se modifica para 
ajustarla al área de impresión. 

 Área de impresión (Printable Area) especifica cómo recortar la 
imagen si el tamaño de impresión solicitado es mayor que el área de 
impresión de la impresora. 
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Más sobre el área de impresión 

Un duplicado de una radiografía suele tener un área de impresión menor que la radiografía original del 
mismo tamaño total.  

 Al imprimir una imagen en un medio del mismo tamaño que la radiografía original, es de esperar 
que se produzca una cierta reducción o recorte (dependiendo de los ajustes de la sección 
Configuración (Configuration) de la IMPRESORA DICOM de destino y de las opciones 
disponibles que proporcionen el servidor y la impresora). 

 Cuando se imprime una imagen más pequeña que el área de impresión de la impresora (que suele 
ser de 14 pulgadas x 17 pulgadas), la imagen resultante tiene el mismo tamaño que el original. 

Ejemplo: supongamos que el área de impresión es de 13,5 pulgadas x 16,5 pulgadas y que la 
resolución es de 150 píxeles por pulgada. El Área de impresión (Printable Area) sería: 

14X17:2025,2475 

donde 14X17: es el tamaño de la radiografía original (debe incluir la “X” mayúscula) 

 2025 es la anchura del área de impresión en píxeles (13,5 pulgadas x 150 píxeles por pulgada) 

 2475 es la longitud del área de impresión en píxeles (16,5 pulgadas x 150 píxeles por pulgada) 

 
 

 Para el Tipo (Type) de destino IMPRESORA POSTSCRIPT 
(POSTSCRIPT PRINTER): 

 

  
 

a. Si hay una tabla de búsqueda disponible para el destino, marque la 
casilla TB (LUT) y pulse el botón ... (indicado por la flecha) para 
seleccionar el archivo de TB. Las TB disponibles están en el directorio 
específico de las impresoras del CD de instalación de ClinicalExpress. 

 
b. Haga clic en Configuración (Settings) para abrir la ventana 

Configurar impresión (Print Setup) estándar. En esta ventana se 
puede seleccionar una impresora y cambiar sus propiedades. 

 
Nota: para poder usar este tipo de destino es necesario instalar 
controladores de impresora postscript. Consulte la información 
de los controladores en el manual de la impresora. 
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 Para el Tipo (Type) de destino CD DICOM (DICOM CD): 
 

  
 

a. Especifique el número de Copias (Copies) que se van a crear. 
 
b. Seleccione la Unidad (Drive) de CD. 

 Para el Tipo (Type) de destino LISTA DE TRABAJO DE MODALIDAD 
(MODALITY WORK LIST): 

 

  
 

a. Active la casilla Usar solo información del paciente (Use Only 
Patient Information) para importar solamente información básica del 
paciente de una consulta de Lista de trabajo de modalidad. 

 
b. Active la opción Habilitar consulta extendida (Enable Broad Query) 

si el sistema puede acceder a múltiples listas de trabajo de modalidad y 
si desea que el usuario pueda buscar todas las MWL con una única 
consulta. 

 
c. Active la opción Usar fecha programada del paso del procedimiento 

como fecha del estudio (Scheduled Procedure Step Start Date to 
Study Date) para asignar la fecha del procedimiento a la fecha del 
estudio al crear una nueva cuenta de paciente consultando el servidor de 
MWL. 

 
d. Active la opción Usar ID de procedimiento solicitado como ID de 

estudio (Requested Procedure ID to Study ID) para asignar la ID de 
un procedimiento solicitado a la ID de un estudio. 

 Para el Tipo (Type) de destino CONSULTA DE PACIENTES DICOM 
(DICOM PATIENT QUERY), no hay opciones de configuración. 

6. Cuando haya introducido toda la información del destino, pulse el botón 
Guardar (Save). El nuevo destino aparece en la sección Destinos (Targets) 
de la ventana Administración (Administration). 
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Gestión de la información de los destinos 
 
 
 Para obtener una lista de los destinos existentes: haga clic en Destinos 

(Targets) en el árbol de administración. 
 

 
 
 
 Para ver la configuración de un destino: haga clic en el nombre del destino 

debajo de Destinos (Targets) en el árbol de administración. 
 
 
 Para editar la información de un destino: 

 
a. Haga clic en el nombre del destino debajo de Destinos (Targets) en el 

árbol de administración. 
  o 
 Haga clic en el nombre del destino en la lista resumida de destinos. 
 
b. Pulse el botón Editar (Edit). Los campos se habilitan y se pueden editar. 
 
c. Cuando haya terminado, pulse el botón Guardar (Save). 

 
 
 Para eliminar un destino: 

 
a. Haga clic en el nombre del destino debajo de Destinos (Targets) en el 

árbol de administración. 
  o 
 Haga clic en el nombre del destino en la lista resumida de destinos. 
 
b. Pulse el botón Eliminar (Delete). 
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Comprobación de la comunicación 

Después de definir un destino es aconsejable comprobar la comunicación entre 
ClinicalExpress y el destino o el agente de MWL (la opción MWL de 
ClinicalExpress se puede adquirir por separado). Por supuesto, también se puede 
comprobar en cualquier otro momento. 

1. En la ventana principal de ClinicalExpress, seleccione Archivo > Generar 
carta de ajuste > SMPTE (File > Generate Test Pattern > SMPTE). Esta 
opción utiliza un estudio especial adquirido que se usa estrictamente para 
efectuar ajustes. 

2. Abra la lista Destino (Target) y haga clic en el destino que se va a comprobar. 

3. En la sección Destino (Target), pulse el botón Verificar (Verify) (justo 
debajo de la lista desplegable de destinos). 

4. Espere a que ClinicalExpress responda. Se obtendrá uno de los dos mensajes 
siguientes: 

 “Destino – [nombre del destino]. Solicitud de verificación correcta” 
(“Target – [target name]. Verification request succeeded.”) indica que el 
destino ha respondido correctamente al comando Eco DICOM de 
ClinicalExpress. 

 “Destino – [nombre del destino]. Solicitud de verificación incorrecta” 
(“Target – [target name]. Verification request failed.”) significa que el 
destino no ha respondido al comando Eco. Si ve este mensaje, compruebe 
los detalles de la configuración del destino en ClinicalExpress y asegúrese 
de que la red funciona correctamente. 

Repaso de la configuración del digitalizador de radiografías 
 
Consulte la configuración del digitalizador en la rama Digitalizador (Digitizer) 
del árbol de Administración (Administration). 
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Comprobación de la disponibilidad de listas de trabajo de 
modalidad 

 
Nota: la opción de Lista de trabajo de modalidad de 
ClinicalExpress se puede adquirir por separado. Para que esta 
función esté disponible, su copia de ClinicalExpress debe tener 
la licencia para la Lista de trabajo de modalidad. 

 
Nota: las instrucciones de este apartado asumen que el 
administrador ha seguido las instrucciones para crear un nuevo 
destino de Lista de trabajo de modalidad (consulte el apartado 
“Definición de destinos” anterior en este mismo capítulo). 

 Para determinar si la opción de Lista de trabajo de modalidad está instalada: 
 

a. En la ventana principal, seleccione, Ver > Estudios adquiridos (View > 
Acquired Studies). 

 
b. En la ventana Información de estudios (Studies Information), 

compruebe la lista Destinos (Targets): 
 Si hay al menos un destino en la lista, la opción de Lista de trabajo de 

modalidad está instalada y ya se ha configurado para un destino de Lista 
de trabajo de modalidad. 

 Si la lista está vacía, la opción de Lista de trabajo de modalidad no está 
instalada. 

 
c. En la ventana Información de estudios (Studies Information), pulse 

Cerrar (Close). 

 Para comprobar si la estación de trabajo de ClinicalExpress está conectada a 
un origen de Listas de trabajo de modalidad: 

 
a. En la ventana principal, abra la lista de Destinos (Targets) y haga clic en 

un destino de Lista de trabajo de modalidad. 
 

  
 
b. Pulse Verificar (Verify). 
 
c. Aparece un mensaje que indica si la conexión está funcionando. 

Nota: para ver instrucciones detalladas del uso de la Lista de 
trabajo de modalidad, véase el apartado “Importar los datos de 
un paciente usando la lista de trabajo de modalidad” de la “Guía 
del usuario de ClinicalExpress”. 
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Revisión y gestión del archivo de registro 
 
El archivo de registro, un archivo de texto que se guarda en el directorio del 
programa, contiene un registro de las acciones realizadas por ClinicalExpress. 
Use el archivo de registro para revisar y analizar las actividades de los usuarios y 
del programa a los efectos de solucionar problemas. ClinicalExpress incluye una 
ventana para consultar y administrar el archivo de registro. 
 
 

 
 
 
 Para ver el archivo de registro: seleccione Ver > Archivo de registro (View 

> Log File). 
 
 Para borrar los datos del archivo de registro: pulse el botón Borrar registro 

(Clear Log). 
 
 Para incorporar nuevos datos al archivo de registro: pulse el botón Renovar 

(Refresh). 
 
 

Nota: configure las opciones del registro en la página de 
administración Local (consulte “Registro” en el apartado 
“Configuración de los parámetros de la estación de trabajo 
local” anterior en este mismo capítulo). 
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Calibración del digitalizador de imágenes 
 
Calibre el digitalizador de radiografías siguiendo las recomendaciones que 
figuran en el manual de funcionamiento del digitalizador. 
 

Nota: la calibración tarda varios minutos, durante los cuales no 
se podrá utilizar el digitalizador ni ClinicalExpress. 

 
 Para calibrar el digitalizador: 
 

a. Seleccione Opciones > Calibrar escáner (Options > Calibrate Scanner). 
 
b. Confirme que desea iniciar la calibración. 
 

  
 
c. Espere a que el digitalizador de radiografías se calibre. 
 

  
 
d. Cuando haya concluido la calibración, pulse Sí (Yes). 
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Calibración de la pantalla 
 
Para que la calidad de la imagen sea buena es importante que se presente en 
pantalla correctamente. Si la pantalla presenta la imagen con exactitud, el usuario 
puede evaluar eficazmente la calidad de la imagen y optimizarla correctamente. 
Aunque la película se haya digitalizado correctamente, en una pantalla sin 
calibrar puede parecer que la imagen es de mala calidad. En este apartado se 
explican dos métodos para calibrar fácilmente la pantalla. 
 
Ponga en conocimiento del físico médico encargado del control de calidad de las 
pantallas los problemas de presentación gráfica. Los problemas de pantalla deben 
someterse a una investigación exhaustiva y, en función de los resultados, se debe 
reajustar, realizar un mantenimiento, reparar o cambiar el aparato. 
 
Para una calibración más rigurosa de la pantalla, VIDAR recomienda utilizar 
productos VeriLUM, disponibles a través de: 
 
 IMAGE Smiths, Inc. 
 P.O. Box 30928 
 Bethesda, MD 20824 EE. UU. 
 
 Teléfono: +1 (240) 395-1600 
 Página web: www.image-smiths.com 
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Calibración con la carta de ajuste de la SMPTE 
 
1. Seleccione Archivo > Generar carta de ajuste > SMPTE (File > Generate 

Test Pattern > SMPTE) para abrir la imagen de la carta de ajuste de la 
SMPTE (representada más abajo). 

 
2. Ajuste al mínimo los controles de brillo y contraste de la pantalla. 
 
3. Aumente el brillo hasta que consiga ver las barras de las esquinas. 
 
4. Aumente el contraste hasta aproximadamente el 80% o más, hasta que pueda 

ver los cuadrados del 0%/5% y 95%/100% de la imagen lo más claramente 
posible. 

 
 

 
 

Cuadrado del 0%/5% Cuadrado del 95%/100% 
 

Nota: si está viendo una copia electrónica de este documento 
en una pantalla y no puede distinguir el cuadrado del 0%/5% o 
el cuadrado del 95%/100% de esta página (indicados por las 
flechas), entonces es necesario calibrar la pantalla. 
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Calibración con la carta de ajuste TG18-QG 

 
1. Seleccione Archivo > Generar carta de ajuste > TG18-QC (File > Generate 

Test Pattern > TG18-QC) para abrir la imagen de la carta de ajuste  TG18-QC 
(representada más abajo). 

 

 
 
 
2. Examine visualmente las siguientes características: 
 

a. Distorsión geométrica: compruebe que los bordes y las líneas de la carta se 
pueden distinguir y son rectos, y que la carta está centrada en el área activa 
del dispositivo de pantalla. 

 
b. Calidad general de la imagen y artefactos: evalúe el aspecto general de la 

carta. Compruebe que no haya pérdidas de la uniformidad ni artefactos, 
especialmente en los cambios de negro a blanco y de blanco a negro. 
Compruebe que las áreas de degradado son continuas y no presentan 
artefactos de contorno. 
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c. Luminancia, reflexión y ruido: compruebe que se pueden distinguir 
claramente las 16 zonas de luminancia. Compruebe que se pueden 
distinguir las zonas del 5% y el 95%. Evalúe la apariencia de las letras de 
bajo contraste y confirme la visibilidad de los elementos de las esquinas de 
todas las zonas de luminancia. 

 
d. Resolución: evalúe la apariencia de los elementos Cx del centro y las 

esquinas de la carta, y asígneles puntuaciones en comparación con la 
referencia. Las puntuaciones deben ser inferiores a 5 para los monitores 
primarios e inferiores a 7 para los secundarios. Compruebe también la 
visibilidad a la frecuencia de Nyquist de las rejillas del centro y las 
esquinas de la carta.* 

 
 
 
 
 
 
 
 
 

Contacte con el Servicio Técnico de VIDAR si tiene cualquier 
duda sobre la configuración del software ClinicalExpress: 

Teléfono: +1 800 471 SCAN (+1 800 471 7226) 

 +1 703 471 7070 fuera de EE. UU. 

Correo electrónico: medtech@3dsystems.com 

 
 
 

                                                      
* Los pasos 2a a 2d han sido reproducidos con la debida autorización de “New 
Developments in Display Quality Control,” por Ehsan Samei, en Quality Assurance and 
Quality Control in the Digital Imaging Department, Eds. E. Siegel, B. Reiner, J. Carrino, 
SCAR Premier Series, Society for Computer Applications in Radiology, Great Falls, VA, 
2002, pp. 71-82. 
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